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We want to thank our customers who use the Touch Operation Panel. 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of each 

device, cables, and configurable systems. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

4. Supported addresses Page 9 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configurations of TOP and "FASTECH – Ezi-SERVO Plus-E Series" are as follows: 

 

Series Communication method Communication setting Cable 

Ezi-Servo II Plus-E  Ethernet TCP 
3. TOP communication setting 

4. TOP external device setting 
5.1. Cable table 1 

 

■ Connection configuration 

 

ㆍ1:1 (one TOP and one external device) connection  

 

 

 

 

 

 

 

 

ㆍ1:N (one TOP and multiple external devices) connection  
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select "FASTECH Co., Ltd." 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

FASTECH : Ezi-Servo Ethernet Tcp Ezi-Servo PlusE 
 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [Project Option > "Use HMI Setup" Check > Edit > Ethernet] 

– Set the TOP communication interface in TOP Design Studio. 
 

 
 

 
 

Items TOP External device Remarks 

IP Address 192.168.0.100 192.168.0.1  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

* The above settings are examples recommended by the company. 
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 (2) Communication option setting 

■ [Project > Project Property > Device Setting > "FASTECH : Ezi-Servo"] 

– Set the options of the Computer Link communication driver in TOP Design Studio. 
 

 

 

Items Settings Remarks 

Interface Select "Ethernet". 
Fixed 

Protocol Select "EziServoPlusE". 

IP Enter the IP address of the external device.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) 
Set the waiting time between TOP’s receiving a response from an external 

device and sending the next command request. 
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3.2. Communication setting in TOP  

* This is a setting method when "Use HMI Setup" in the setting items in "3.1 TOP Design Studio" is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Ethernet] 
 

 

Items TOP External device Remarks 

IP Address*Note 1) Note 2) 192.168.0.100 192.168.0.1  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 0 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 

 

Items Description 

IP Address Set an IP address to be used by the TOP to use over the network. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 

. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

 

 

Items Settings Remarks 

Interface Select "Ethernet". 
Fixed 

Protocol Select "EziServoPlusE". 

IP Enter the IP address of the external device.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) 
Set the waiting time between TOP’s receiving a response from an external 

device and sending the next command request. 
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the port (ETH1/ETH2) settings you want to use in [Control Panel > Ethernet] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch "Communication diagnostics" in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

External device CPU name OK NG 

 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

Check address range  

OK NG 

4. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. Supported addresses 

■ The devices available in TOP are as follows:  
 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

INFO_DRIVER_VER X 0 – 0 
Read the version information on a connected external 

device. 
16 R  

INFO_DRIVER_NAME X 0 – 0 Read the name of a connected external device. String R  

INFO_MOTOR_NO X 0 – 0 Read the number of a connected motor. 16 R  

SAVE_ROM_PARAM 0.0 – 0.0 X 
Save the currently set parameter values and allocation 

values of I/O signals in the drive ROM memory. 
1 W  

PARAM 
0.0 – 

32.31 

0–32 

Parameter  

Number 

Read operation (R): Read the parameter of a registered 

word address number from the RAM memory. 

Write operation (W): Save the parameter value of a 

registered word address number in the RAM memory. 

32 R/W  

LOAD_ROM_DIOMAP 0.0 – 0.0 X 
Read the setting status of the control IO signal and the 

level setting value of the signal from the ROM memory. 
1 W Note 1) 

SERVO_ONOFF 0.0 – 0.0 X 

Set Servo ON/OFF status. 

0 : Servo OFF 

1 : Servo ON 

1 W Note 1) 

SERVO_ALMRST 0.0 – 0.0 X Reset Servo Alarm status. 1 W Note 1) 

ALM_STATUS X 0 – 0 

Request current alarm status and information. 

♦ Alarm Type 

0 : No Alarm 

1 : OverCurrent 

2 : OverSpeed 

3 : StepOut 

4 : OverLoad 

5 : OverTemperature 

6 : BackEMP 

7 : MotorConnect 

8 : EncoderConnect 

9 : MotorPower 

10 : Inposition 

11 : SystemHalt 

12 : ROMdevice 

15 : Position Overflow 

16 R  

MOVE_STOP 0.0 – 0.0 X Request to stop the motor which is currently running. 1 W Note 1) 

MOVE_ESTOP 0.0 – 0.0 X 
Request to emergency stop the motor which is currently 

running. 
1 W Note 1) 

MOVE_HOME 0.0 – 0.0 X 
Request to start homing operation under the condition 

of the currently set parameter. 
1 W Note 1) 

MOVE_PAUSE 0.0 – 0.0 X 

Request to pause and unpause the current operating 

status. 

0: Unpause 

1: Pause 

1 W Note 1) 

STATUS_FLAG 0.0 – 0.31 0 – 0 

Request a flag value which indicates operating status. 

For information on the operating status flag,  

refer to the Bit setting section of the Fastech manual 

status Flag. 

32 R  
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Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

LOAD_ROM_PARAM 0.0 – 0.0 X 
Read a specific parameter value of the ROM memory 

area. 
1 W  

LOAD_ROM_PARAM_

NO 
X 0 – 0 ROM parameter number to be read 16  Note 2) 

ROM_PARAM X 0 – 0 Parameter data value which has been read 32  Note 2) 

Ex) Read the 2nd parameter value of the ROM area to be saved in the ROM_PARAM device when LOAD_ROM_PARAM 

device write operation is carried out if the data value of LOAD_ROM_PARAM_NO device is 2. 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

DIO_MASK 
0.0 – 

22.31 

0 – 22 

Pin 

number 

Read operation (R): Read the pin control IO setting 

status of a registered word address number. 

 

Write operation (W): Set the control IO signal to the 

pin of a registered word address number. 

 

32 R/W  

DIO_LEVEL 
0.0 – 

22.31 

0 – 22 

Pin 

number 

Read operation (R): Read pin control IO signal level of 

a registered word address number. 

 

Write operation (W): Set the control IO signal level to 

the pin of a registered word address number.  

0 : Active Low 

1 : Active High 

 

32 R/W  

 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

COMP_OUT_TRIG 0.0 – 0.0 X 
Create a control output signal (Compare Out) upon 

write operation. 
1 W Note 1) 

COMP_OUT_POS X 0 – 0 Compare Trigger start position 32  Note 2) 

COMP_OUT_PERIOD X 0 – 0 Compare Trigger Pulse cycle 32  Note 2) 

COMP_OUT_WIDTH X 0 – 0 Compare Trigger Pulse width 32  Note 2) 

COMP_OUT_STATUS 0.0 – 0.0 X 

Current signal (Compare Out) output function reads the 

operating status. 

0: Ended  

1: Outputting 

1 R  

Ex) Upon COMP_OUT_TRIG operation, the operation is requested based on the data values of COMP_OUT_POS, 

COMP_OUT_PERIOD, and COMP_OUT_WIDTH devices.  
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Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

DINPUT 
0.0 – 

0.31 
0 – 0 

Read operation (R): Read the current input signal status 

of the control input terminal. 

 

Write operation (W): Set the input signal level of the 

control input terminal.  

If a specific bit value is 1, the corresponding input 

terminal signal becomes ON. 

 

32 R/W  

DINPUT_CLR 
0.0 – 

0.31 
0 – 0 

Set the input signal level of the control input terminal. 

If a specific bit value is 1, the corresponding input 

terminal signal becomes OFF. 

 

32 W  

DOUTPUT 
0.0 – 

0.31 
0 – 0 

Read operation (R): Read the current output signal 

status of the control output terminal. 

 

Write operation (W): Set the output signal level of the 

control output terminal.  

If a specific bit value is 1, the corresponding output 

terminal signal becomes ON. 

 

32 R/W  

DOUTPUT_CLR 
0.0 – 

0.31 
0 – 0 

Set the output signal level of the control output terminal. 

If a specific bit value is 1, the corresponding output 

terminal signal becomes OFF. 

 

32 W  

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

USER_OUT_STATUS 
0.0 – 

8.16 

0 – 8 

PIN 

Number 

 Read the current PIN output status of a registered 

word address. 

0 : STOP 

2 : RUN 

16 R  

USER_OUT_TIME X 0 – 8 
Output ON time set in the PIN of a registered word 

address 
16 R  

USER_OUT_POS X 
0:00 – 

8:59 

Information on output location array set in the PIN of 

a registered word address 
32 R  

USER_OUT_PCNT X 0 – 8 
Number of output location set in PIN of a registered 

word address 
16 R  

       

SET_USER_OUT_TRIG 0 – 8 X 
Create an output at a specific location on the set 

output. 
1 W Note 1) 

SET_USER_OUT_TIME X 0 – 0 
Output On time  

(Unit: ms, 1 – 65535) 
16  Note 2) 

SET_USER_OUT_POS X 
0:00 – 

8:59 

Output location array  

For word address 5:31 

User Out number: 5 

Output location array: 31 

32  Note 2) 

SET_USER_OUT_PCNT X 0 – 0 
Number of output positions 

(number of registered output location arrays) 
16  Note 2) 

Can be used after setting the output signal to User Out. 



 

 

External device connection manual for TOP Design Studio 12 / 16 

Ex) Upon SET_USER_OUT_TRIG operation, the operation is requested based on the data values of SET_USER_OUT_TIME, 

SET_USER_OUT_POS, SET_USER_OUT_PCNT devices. 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

MOVE_ABS_TRIG 0.0 – 0.0 X 
Request to start movement operation as much as the 

absolute value [pulse] position. 
1 W Note 1) 

MOVE_ABS_POS X 0 – 0 Absolute position value for movement operation 32  Note 2) 

MOVE_POS_SPD X 0 – 0 Speed value of position movement operation [pps] 32  Note 2) 

Ex) Upon MOVE_ABS_TRIG operation, the device operates based on the data values of MOVE_ABS_POS and 

MOVE_POS_SPD devices. 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

MOVE_INC_TRIG 0.0 – 0.0 X 
Request to start movement operation as much as the 

relative value [pulse] position. 
1 W Note 1) 

MOVE_INC_POS X 0 – 0 Relative position value for movement operation 32  Note 2) 

MOVE_POS_SPD X 0 – 0 Speed value of position movement operation [pps] 32  Note 2) 

Ex) Upon MOVE_INC_TRIG operation, the device operates based on the data values of MOVE_INC_POS and 

MOVE_POS_SPD devices. 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

MOVE_LIMIT+ 0.0 – 0.0 X 

Request to start LIMIT+ operation under the currently 

set parameter conditions.  

0 : STOP 

1 : LIMIT+ operation  

1 W Note 1) 

MOVE_LIMIT- 0.0 – 0.0 X 

Request to start LIMIT- operation under the currently 

set parameter conditions.  

0 : STOP 

1 : LIMIT- operation 

1  Note 1) 

MOVE_SPD X 0 – 0 Speed value of movement operation [pps] 32  Note 2) 

Ex) Upon MOVE_LIMIT+,- operation, the device operates based on the data value of MOVE_SPD device. 

*. When changing the direction during operation, the direction must be changed while in the STOP status. 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

MOVE_JOG+ 0.0 – 0.0 X 

Request to start JOG+ operation under the currently 

set parameter conditions.  

0 : STOP 

1 : JOG+ operation  

1 W Note 1) 

MOVE_JOG- 0.0 – 0.0 X 

Request to start JOG operation under the currently set 

parameter conditions.  

0 : STOP 

1 : JOG- operation 

1  Note 1) 

MOVE_SPD X 0 – 0 Speed value of movement operation [pps] 32  Note 2) 

Ex) Upon MOVE_JOG+,- operation, the device operates based on the data value of MOVE_SPD device. 

*. When changing the direction during operation, the direction must be changed while in the STOP status. 
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Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

MOVE_OVERRIDE_A

BS_TRIG 
0.0 – 0.0 X 

Request to change the target absolute position value 

[pulse] value during operation.  
1 W Note 1) 

MOVE_ABS_POS X 0 – 0 Absolute position value for movement operation 32  Note 2) 

Ex) Upon MOVE_OVERRIDE_ABS_TRIG operation, the device operates based on the data value of MOVE_ABS_POS device. 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

MOVE_OVERRIDE_I

NC_TRIG 
0.0 – 0.0 X 

Request to change the target relative position value 

[pulse] value during operation.  
1 W Note 1) 

MOVE_INC_POS X 0 – 0 Relative position value for movement operation 32  Note 2) 

Ex) Upon MOVE_OVERRIDE_INC_TRIG operation, the device operates based on the data value of MOVE_INC_POS device. 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

MOVE_OVERRIDE_S

PD_TRIG 
0.0 – 0.0 X 

Request to change the operating speed value [pps] 

during operation.  
1 W Note 1) 

MOVE_SPD X 0 – 0 Speed value of movement operation [pps] 32  Note 2) 

Ex) Upon MOVE_OVERRIDE_SPD_TRIG operation, the device operates based on the data value of MOVE_SPD device. 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

CMD_POS X 0 – 0 

Read operation (R): request the value [pulse] of the 

target position of that which is currently being followed 

(Command Position) 

 

Write operation (W): set a target position (Command 

Position) value [pulse]. 

32 R/W  

ACT_POS X 0 – 0 

Read operation (R): request the current actual position 

(Actual Position) value [pulse]. 

 

Write operation (W): set the current actual position 

(Actual Position) value [pulse]. 

32 R/W  

POS_ERR X 0 – 0 

Request the difference value [pulse] between the current 

target position (Command Position) and the actual 

position (Actual Position) value. 

32 R  

CURRENT_SPD X 0 – 0 Request the current operating speed value [pps]. 32 R  

CLEAR_POS 0.0 – 0.0 X 
Set the target position (Command Position) and actual 

position (Actual Position) values to 0. 
1 W Note 1) 
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Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

LOAD_ROM_PT 0.0 – 0.0 X 
Read all PT item values in the ROM memory area of the 

drive. 
1 W Note 1) 

SAVE_ROM_PT 0.0 – 0.0 X 
Store all PT item values in the ROM memory area of 

the drive. 
1 W Note 1) 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

PT_RUN_TRIG 0.0 – 0.0 X 
Start the operation of the position table starting from 

the designated PT number. 
1 W Note 1) 

PT_NUMBER x 0 – 0 PT number to start operation 16  Note 2) 

Ex) Upon PT_RUN_TRIG operation, the device operates based on the data value of PT_NUMBER. 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

PT_ITEM X 
0–255 : 

0–28 

Read operation (R): read a specific value (Offset) from 

the PT items in the RAM memory of the drive. 

 

Write operation (W): store a specific value (Offset) 

among the PT items in the RAM memory of the drive. 

 

Word Address  

0–255: PT number 

0–28: Word Offset of an item 

16  

/ 

32  

R/W  

Ex) 

When PT_ITEM7:7 device is drawn to be registered, read the Decel Time value of the 7th PT upon read operation or 

save it upon write operation. 

When PT_ITEM5:4 device is drawn to be registered, read the High Speed value of the 5th PT upon read operation or 

save it upon write operation. 

 

Set the object Size to 32 for items of 32-bit size among the position table items. 

 

*. Please refer to the position table items in the Fastech manual for specific item word offset value of PT. 
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Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

PUSH_MOVE_TRIG 0.0 – 0.0 X 
Request to start push motion operation to maintain 

a fixed force. 
1 W Note 1) 

PUSH_START_SPD X 0 – 0 Speed value of position movement starting [pps] 32  Note 2) 

PUSH_POS_SPD X 0 – 0 Speed value of position movement operation [pps] 32  Note 2) 

PUSH_ABS_POS X 0 – 0 Absolute position value of position movement 32  Note 2) 

PUSH_POS_ACC X 0 – 0 Acceleration time of position movement [ms] 16  Note 2) 

PUSH_POS_DEC X 0 – 0 Deceleration time of position movement [ms] 16  Note 2) 

PUSH_TORQUE_RATIO X 0 – 0 Push motion torque ratio [%] 16  Note 2) 

PUSH_MOTION_SPD X 0 – 0 Push motion operating speed value [pps] 32  Note 2) 

PUSH_END_POS X 0 – 0 Push motion absolute position value 32  Note 2) 

PUSH_MODE X 0 – 0 Push mode 16  Note 2) 

Ex) Upon PUSH_MOVE_TRIG operation,  

the device operates based on the data values of PUSH_START_SPD, PUSH_POS_SPD, PUSH_ABS_POS, PUSH_POS_ACC, 

PUSH_POS_DEC, PUSH_TORQUE_RATIO, PUSH_MOTION_SPD, PUSH_END_POS, and PUSH_MODE. 

 

For details, refer to the Push Motion function in the Fastech manual. 

*. Be sure to execute MOVE STOP(ESTOP) command must be executed before the next motion command. 

 

 

 

Device 
Bit 

Address 

Word 

Address 
Comment 

Size 

(Bit) 
R/W Remarks 

PUSH_STATUS X 0 – 0 

Read the current push motion operation status. 

 

*. Push motion status 

0 : Waiting status for general position movement 

1 : In push motion, the work is not in contact. 

2 : In contact with the work, and the force is maintained. 

3 : The push motion has been completed, but the work 

is not in contact.  

In this case, be sure to execute the STOP (ESTOP) 

command before the next motion command. 

16 R  

 

 

Note 1) The action command address is not displayed in the general object address. *. How to use action-only addresses 

Note 2) This is a device for parameter setting for a write-only device to use a specific function. 
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Appendix 

 

1. Action command address  

 

Unlike general addresses, operation-only addresses are not visible in the Address when registering objects. 

You can register an action-only address in the address editor which performs actions like the action function of Effect 

& Action in the Object Property. 

The reverse action is not supported for action-only addresses. 

 

 

* How to use action-only device 

[Object Property Window] → [Effect & Action] → [ Action ] → [ Bit or Select Word ] → [ Select Write-Only Device of External 

Device] → [Set Action Condition]  

 

 

 


